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ABSTRACT 

 

This paper presents a new method and tool for sequential behavioral data analysis. 

Many current behavioral data analysis studies highlight that the analysis process is 

iterative, and driven by the analyst and their research question. We go one step further by 

implementing a knowledge-representation tool to capture and help refine the analyst’s 

expertise. This tool helps the analyst build an ontology of symbols and semantics to 

describe the activity. In parallel, it helps the analyst define transformation rules to process 

the raw qualitative or quantitative data stream into abstract activity traces based on the 

ontology. The analyst visualizes these traces and iteratively refines the ontology, the 

transformation rules, and the visualization format. This iterative process helps the analyst 

make sense of the initially overwhelming behavioral data, and create user models, 

propose recommendations for interface design, user training, or user assistance. 
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1. INTRODUCTION 

We introduce here a tool for helping analysts to take multi-stream quantitative or 

symbolic data and create models of a subject performing an activity. The term “analyst” 

may refer to psychologists interested in building theories of a subject’s cognition, 

ergonomists interested in designing better user interfaces, analysts trying to predict the 

subject’s behavior in specific conditions, trainers interested in improving training 

techniques, or even the subjects themselves interested in improving their performance. 

The analyst has the central role in this knowledge-discovery or sense-making process, 

because the discovered knowledge or sense is meaningful to her.  

At first, analysts have to set up ways to observe and record the subject’s activity. 

Indeed, human behavior is a complex object of study per se, and its study could only 

arise with the help of software facilities. The recorded data has been designated by the 

term protocol (Ericsson & Simon, 1993) or simply sequential data (Sanderson & Fisher, 

1994). In this paper, we prefer the term activity trace because it conveys the idea that it is 

something intended to be interpreted by somebody. We think of a trace as a footprint that 

helps who sees it understand what happened, at least to some extent. On the contrary to a 

footprint, however, our traces are not accidentally produced but result from the analyst’s 

choices and setup.  
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Many software tools have been implemented for activity trace analysis. (Hilbert 

& Redmiles, 2000) gives a review of forty of them. These tools cannot alone produce a 

comprehensive explanation of human behavior but they interactively support the analysis 

work. This analysis work consists of identifying, categorising, labelling, and transforming 

pieces of the recorded activity. We summarise this process by the notion of “abstraction”.  

The analysts use their expertise and knowledge to formulate a whole set of tiny 

hypotheses and choices concerning how to collect the data, how to filter it, how to cluster 

and label it, and how to display and to report it so that it responds to the analysis purpose. 

Although most of these tools acknowledge the central role of the analysts and the 

importance of their knowledge and expertise in the analysing process, these tools still 

lack knowledge representation mechanisms to support the management of this 

knowledge. For instance, one of the current tools that goes the farthest in that direction, 

MacShapa (Sanderson, McNeese, & Zaff, 1994), does help analysts label and cluster the 

behavioural data. It also acknowledges the usage of these labels as symbols to describe 

the activity. It however does not help the analyst formulate and manage the symbolic 

inferences she can make from these symbols.  

In this paper, we present a tool that addresses this need for a management of the 

analyst’s expertise. This system uses ontology management facilities and rule engines to 

capture the hypotheses and choices made by the analyst. When interactively used by the 

analyst, or a group of analysts, these facilities help formalize the way analysts find 

interesting symbolic patterns and infer models from them. Once this knowledge is 
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formalized, the system uses it to automatically compute new representations of the 

activity from the collected data. The system also helps analysts organize and store 

different categories of choices used for different studies and help capitalize on these 

studies.  

The paper is organized as follows: section 2 presents the principles of activity trace 

modelling and explains its pragmatic and evolutionist nature that underlies the method 

and tool. Examples are taken from a study of car driving (Georgeon, 2008a) made with 

this tool. Section 3 presents the technical features of the system and its architecture while 

section 4 presents its interface and its usage.  

2. MODELING ACTIVITY TRACES 

The notion of activity trace is widely used in the human behavior literature and we 

cannot attribute its origin to a specific author. Only more specific related notions can be 

identified, such as pattern languages, as reviewed by Dearden and Finlay (2006), or 

grammar techniques (Olson, Herbsleb, & Reuter, 1994). Despite the wide usage of the 

term activity trace, we could not find a definition of it, which led us to propose the 

following definition:  

An activity trace is a meaningful inscription, from the viewpoint of an analyst, of the 

flow of what has happened, from the viewpoint of a subject.  
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With this definition, we want to highlight that an activity trace always implies 

two viewpoints, situated in two different moments. It implies the subject’s viewpoint, 

when he or she was performing the activity, and the analyst’s viewpoint, when he or she 

is analyzing the activity trace. Indeed, an activity trace cannot be an inscription of all 

what happened (if that had any sense), because an activity only concerns what relates to 

the subject’s perspective, goals and intentions. The analyst thus inevitably has to make 

assumptions about what is meaningful to the subject when modeling the activity trace. In 

addition, the activity trace depends on what activity aspects interest the analyst and what 

makes sense to her according to her previous knowledge and to her analysis goals.  

Because an activity trace depends on the analyst’s assumptions, it can only be 

modeled in an iterative way, each iteration producing new knowledge leading to new 

hypotheses for the next iteration. Ericsson and Simon (1993) described this iterative 

nature of human behavior studies by: “In designing our data-gathering schemes, we make 

minimal essential theoretical commitments, then try to use the data to test stronger 

theories” (p. 274). Moreover, none of the iterations can produce knowledge that could be 

proven to be true in an absolute sense, but only knowledge that is more efficient and 

useful with regard to the analyst’s goals, and which is more convincing to the analyst’s 

community than the knowledge from the previous iteration. More broadly, this 

conception of knowledge relates to a pragmatic epistemology (James, 1907) and an 

evolutionist epistemology (Popper, 1972).  
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These pragmatic and evolutionist aspects are crucial when defining a 

methodology and a tool for activity trace modeling. By fully acknowledging these 

aspects, we have designed a tool that facilitates and accelerates the evolutionist modeling 

process. The tool helps formulating series of micro-hypotheses of possibly-useful 

symbols, possibly-useful transformation rules to transform the low-level data into higher-

level data, and possibly-useful representations of the observed activity based on these 

hypotheses. If the obtained representation does not help the analyst understand the 

activity better, then she rejects these micro-hypotheses; if it helps, then she keeps them. 

The tool is designed to shorten this formulation / usage / validation or rejection loop. This 

process leads to the construction of a set of micro-hypotheses that are validated by the 

analyst. This set constitutes a formalization of the analyst’s knowledge about how to 

understand the activity. The tool stores this knowledge, helps the analyst keep track of it, 

and helps the analysts’ community discuss and question it.  

The next section details how the tool reaches this goal by helping the analyst define 

sequences at the right level of abstraction, and simultaneously identify interesting 

subsequences, define them precisely, and query the whole trace in search for their 

occurrences.  

2.1. Collecting a symbolic trace 

A raw activity trace can be made of any kind of data describing a subject’s activity 

flow and intended for an analyst’s usage. In a broad sense, it can range from video or 
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audio recording to computer “logs”. Their only common point is that it is temporally 

organized, meaning that each data piece is associated with a timestamp referring to a 

common time base. The first abstraction step consists of converting these raw traces into 

sequences of symbols. These symbols have to be meaningful to the analyst and they are 

chosen on a pragmatic and evolutionist basis for the reasons explained in section 2. The 

encoding process of the raw trace to the symbolic trace can be manual, semi-automatic or 

automatic. The definition of the symbols may evolve in parallel with the encoding 

process implementation because the meaning actually produced by the transformation 

rules may differ from the meaning that was initially intended.  

For example, in a study of car driving, we have used classical mathematical curve 

analysis method to generate symbols of interest from numerical values of the vehicle 

speed, the steering wheel angle, and the pedal positions. In this case, the symbols 

correspond to threshold crossing, local extremum, and inflexion points. These symbols 

are associated with properties of interest such as the derivate value of the brake pedal at 

the threshold crossing which indicates the abruptness of the braking. Figure 1 illustrates 

this discretization process. 
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 Figure 1. Discretization of analogical traces (Georgeon, 2008a).  

In Figure 1, the curves represent the vehicle speed in km/h, and the brake pedal 

position in percentage of range. Symbols of interest are shown on these curves as circles. 

The symbols are merged into the symbolic trace that is represented at the bottom of the 

figure. The figure also shows the derivate value of a brake pedal threshold crossing as an 

example of property of interest associated with a symbol. The analyst specifies the way to 

generate these symbols so that they correspond to meaningful events that describe the 

activity. 

Our experience taught us that the system must keep a connection between the raw 

trace and the symbolic trace, and provide parallel displays of both of them. The analyst 

needs to tune many parameters of the discretization algorithms, like the threshold values 

or noise filters. The analyst validates the chosen symbols and algorithms by comparing 

the symbolic trace to the raw trace and ensuring that the symbolic trace well represents 

what is happening. Moreover, while the symbolic trace is useful for indexing the raw 
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trace and for building an abstract representation, it inevitably loses low-level 

information and the analyst sometimes needs to go back to the raw trace during the 

analysis process. 

2.2. Modeling the symbolic trace 

At the symbolic level, analysts most often want to focus on relations between events. 

Indeed, events are not meaningful by themselves, but they become meaningful in the 

context where they relate to each other (Sanderson & Fisher, 1994). Examples of such 

relations can be “sequential following within a certain period of time”, “co-occurrence 

within a certain period of time”, and “causality with regard to a certain explanative 

theory”. Building and understanding these relations between events is a part of the 

analyzing process. By definition, a set of elements connected through relations is a graph. 

Therefore, we model the symbolic traces with a graph structure.  

More precisely, our trace graph structure has two parts: a sequence and an ontology. 

The sequence is a part of the graph that is made of event instances and of relation 

instances between event instances. The ontology is a part of the graph that is made of 

event classes and of relations between event classes. Figure 2 illustrates this graph 

structure with a simplified example taken from the car driving study. 
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Figure 2: Activity trace modeled in a knowledge engineering system. 

The sequence is represented in the lowest part of Figure 2 and the ontology in the 

highest part. In the sequence graph, event instances are represented as circles and 

triangles. Relation instances between event instances are represented as solid arrows 

between these circles and triangles. Some properties of event instances are represented 

with gray dashed arrows pointing to their value at the bottom of the figure.  

Our tool displays the sequence in a similar form as shown in Figure 2, the exact form 

is shown in Figure 4. This display uses two axes: the time axis and the “abstraction” axis. 

That is, the events’ time-code attribute determines their “x” coordinates, and the analyst 

specifies their “y” coordinates when she configures these event’s class in the ontology. 

The analyst can use the “y” coordinate to express different meanings; our 
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recommendation is to use it to express an idea of abstraction level related to a 

specific analysis. In this example, the lowest level (circles) represents the events obtained 

from the discretization process; the intermediary level represents events that describe the 

activity in usual driving terms: accelerate, glance, blinker; and the higher level represents 

events describing lane change behavior: indicator of intention to change lane, index of 

lane change. This example expresses the analyst’s assumption that the conjunction of an 

acceleration and a glance to the left rear mirror can be an indicator of the driver’s 

intention to change lane. 

In the ontology graph, the nodes represent event classes, and the edges represent the 

relation “subclass of” (dashed black arrows). The analyst defines the ontology during the 

modeling process. For example, the “Collected” class includes all the event classes that 

come from the discretization process. The “Driving descriptors” class gathers the 

intermediary event classes that describe the activity in usual driving terms. The “Lane 

Change descriptors” class gathers the most abstract event classes describing lane changes. 

The dotted gray arrows in the figure represent the relation “type of” going from event 

classes defined in the ontology to event instances in the sequence.  

Again, like most ontologies, this ontology is made by the analyst on a pragmatic 

basis. It is likely that two analysts will create two different ontologies. While the software 

cannot demonstrate that one is better than the other, it does help the analysts formalize 

and discuss them. This discussion leads to the construction of a language for describing 

the activity that represents an agreement about the terms that can be used to describe the 
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activity. In addition, the ontology also supports the analysts’ agreement about how 

the trace should be visualized, because the visualization properties of the symbols are 

stored in the ontology.  

This trace formalism enables the analyst to conduct a hierarchical analysis of the 

activity. Event instances can be seen as hierarchically organized because some event 

instances represent lower-level events and other represent more general events. The 

ontology also defines a hierarchy because some event classes are sub-classes of others. 

These two hierarchies are however different because lower-level event instances do not 

necessarily belong to a sub-class of the class of higher-level event instances. 

3. SYSTEM IMPLEMENTATION 

Our system is based on an assemblage of open source knowledge-engineering tools: 

an ontology editor, an inference engine, visualization facilities, and documentation 

facilities. This system is named ABSTRACT (Analysis of Behavior and Situation for 

menTal Representation Assessment and Cognitive acTivity modeling). Figure 3 

illustrates this assemblage. 



USER MODELING FROM ACTIVITY TRACES 

 

 

14 

 

 Figure 3: ABSTRACT architecture.  

The system can be split into three levels: a lower level, at the bottom of the figure, 

which is the Collection system; a core level, in the center of the figure, which is the 

Symbolic trace system itself; and a higher level, on the top of the figure, which is a 

Documentation level. 

3.1. The collection system 

The collection system gathers tools to help the analyst prepare the symbolic trace. We 

call these tools collection agents. Collection agents may be automatic when specified 
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once by the analyst, or may require the analyst’s intervention. Automatic collection 

agents can be tools for preprocessing sensor data or computer logs, as in the example of 

section 2.1. Semi-automatic collection agents can be tools for helping the analyst take 

notes, record interviews, or encode video data. As said, this discretization cannot be done 

blindly, but must be driven by the analyst. Hence, this level requires visualization 

facilities. We use Microsoft Excel with specific Visual Basic macros (VBA) as a 

visualization tool for the collection system. In this visualization, each event of the 

symbolic trace is displayed as a line in the spreadsheet. The lines are colored according to 

the event’s type, and the events’ properties are organized in different columns. We have 

implemented a specific video player that triggers VBA macros that automatically scrolls 

down the spreadsheet in synchronization with the video, allowing the analyst to check 

and validate or reject the collected symbolic trace. At this level, other similar tools can be 

used, for instance MacShapa (Sanderson et al., 1994) also provide this visualization 

facilities in synchronization with video. 

3.2. The symbolic trace system 

The symbolic trace system is the knowledge-engineering system itself. At this level, 

the traces are modeled as described in section 2.2. In addition, they are associated with a 

set of inference rules and a set of “style-sheets”. A style-sheet is a specification for 

displaying the trace on the screen. It specifies how semantic properties of the events that 

are defined in the ontology should be converted into visualization properties, such as 

shape and position. Style-sheets also implement particular time scales, and particular 
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filters to display only the interesting aspect of the trace for a particular analysis. 

They correspond to different ways of looking at the trace according to different modeling 

goals.  

The inference rules are the rules that produce inferred symbols from patterns of 

previously existing symbols. The principle is to query the graph in the search for 

subgraphs that match certain patterns, and to attach new nodes and arcs to the matching 

subgraphs. These new nodes represent the inferred symbols and the new arcs represent 

the “inference” relations. The usage of this inference mechanism is further described in 

section 4.2. 

Technically, the “sequence” part of the activity traces are encoded as RDF graphs 

(Resource Description Framework). We choose RDF because it is the most widely used 

specification for graph encoding. We use XML as a serialization of RDF to store 

sequences, because XML makes them easy to exchange with other applications. The 

ontology is encoded as RDFS (RDF-Schema), because RDFS is the simplest ontology 

language based on RDF. We use Protégé as a graphical ontology editor. That is, an 

installation of Protégé is embedded in our tool, and the analyst uses it to define the 

ontology of his traces. The graphical displays of our traces are encoded under the SVG 

(Scalable Vector Graphic) specification. Because Firefox natively supports SVG, we use 

it as a visualization tool, and we have implemented the most part of the tool as a web 

application in PHP. We use XSL (Extensible Stylesheet Language) as a transformation 
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language for transforming RDF traces into their SVG graphical representation. We 

use SPARQL as a query language for graphs, as we will explain in section 4.2. 

3.3. The documentation system 

Analysts using our symbolic trace system expressed the need for a higher system 

layer providing a way to both index and attach documentation to episodes of interest. We 

implemented this by associating the symbolic trace system with a wiki. As we have made 

the choice of implementing this tool as a web application, analysts can reference each 

episode of interest by their URL, and easily paste this URL into a wiki page.  Moreover, 

some new wiki implementations, like Semantic Mediawiki1, include semantic facilities. 

We are still investigating how these semantic facilities can help organize knowledge 

constructed from activity traces. It could be used to merge the ontology editor with the 

documentation system into a single semantic documentation system. This would be 

appropriate for activity trace analysis, where semantic and documentation has to be 

associated. 

                                                

1 Semantic Mediawiki (http://semantic-mediawiki.org) 
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4. SYSTEM USAGE 

4.1. The user interface 

The user interface is accessible as a web-page in any browser that supports SVG, 

such as Firefox. This interface is illustrated in Figure 4. It has four tabs: the “Open” tab 

that allows the analyst to select a trace in a list; the “Info” tab that displays general 

information about the selected trace, such as its creation date and its version, and the 

management of stylesheets; the “View” tab that displays graphical visualizations of the 

trace; and the “Edit” tab that allows the analyst to write queries to transform the trace. 

The interface also provides a link to the ontology editor Protégé. 

 

Figure 4: ABSTRACT User interface. 
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The “View” tab shown in Figure 4 provides the following functionalities: 

1. Consultation of the trace reference. 

2. Selection of different visualization style sheets in drop-down lists. Different 

visualizations can be displayed simultaneously on the screen, and their time-code 

is synchronized. 

3. Time code: this value corresponds to the cursor position in the visualization 

modules (vertical red line). The analyst can enter a time code and click “Go to” to 

focus on it.  

4. Visualization example with a time span of 10 seconds. The analyst can scroll the 

trace left and right with the mouse. This visualization example corresponds to the 

simplified description given in Figure 2.  

5. Visualization example of an entire trace (20 minutes), with only the high-level 

symbols displayed. 

6. The analyst can show the symbols properties by clicking on the symbols. 

7. The system can synchronize with a video player. When this box is checked, the 

system gives the timecode control to the video player and automatically follows 

it. 

These trace examples come from our car driving study and are further explained in 

(Georgeon, 2008a, 2008b; Henning, Georgeon, & Krems, 2007). Since the system 

provides a way to define the labels, shapes, colors, and “y” positions of symbols, the 
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analyst can use graphical conventions that makes her trace easy to read in the 

context of her study.  

4.2. The transformation mechanism 

The analyst uses the “Edit” tab to write queries that infer higher-level symbols from 

patterns of lower-level symbols. For instance, Table 1 illustrates a query to infer the 

“Lane Change indicator” symbol shown in Figure 2, which indicates that a lane change is 

about to happen. In this example, the analyst wants to test the hypothesis that this 

indicator can be inferred from a conjunction of an “accelerate” event with an acceleration 

value greater or equal than 1 m/s2, followed by a “Glance” event pointing to the left 

mirror, both being held in a time period of 1 second. 

The graph elements, either from the sequence or the ontology, are handled as triples 

[node, edge, node]. A query consists of a SELECT clause and a CONSTRUCT clause. 

The SELECT clause specifies a pattern of triples that should match the graph, and the 

CONSTRUCT clause specifies a pattern of triples that should be added to the graph 

wherever a pattern matches the SELECT clause. In addition, matching patterns can be 

restricted by a FILTER clause. The syntax shown in Table 1 has been simplified for 

clarity. The complete SPARQL syntax can be found in the SPARQL documentation2. 

                                                

2 http://www.w3.org/TR/rdf-sparql-query/ 
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Table 1: Simplified inference query. 

CONSTRUCT  
(?r1, infer , Indicator_Symbol) 
(?r2, infer , Indicator_Symbol) 
(Indicator_Symbol, type , Lane_Change_Indicator) 
WHERE 
(?r1, type , Accelerate) 
(?r2, type , Left_Mirror_Glance) 
(?r1, time-code , ?d1) 
(?r2, tine-code , ?d2) 
(?r2, Acceleration_Value , ?v1) 
FILTER 
( ?v1 > 1) 
(sequence(?d1,?d2,1)) 

In this query, ?r1, ?r2, ?d1, ?d2, and ?v1 represent variables. Each of them must 

match the same graph element each time they appear in the query.  For instance, it must 

be the same event ?r1 that is of type Accelerate, that has the time-code ?d1, and that is the 

origin of the infer relation towards the new Indicator_Symbol. This example assumes that 

the property Acceleration_Value has been copied to the Accelerate event when it was 

created during the first level of analysis. The “sequence” function tests that the time-

codes ?d1 and ?d2 are comprise within the time period of 1 second. 

In our implementation, the analyst has to know SPARQL to specify queries on the 

trace. To make it simpler, however, we have implemented a template mechanism that 

prepares skeletons of queries. We have also added some customized functions in our 

implementation of SPARQL, such as the “sequence” function presented above. These 

functions facilitate the specification of queries that compare time codes of events, and 

make it easier to specify temporal constraints. In so doing, we are implementing a 

semantics of time, for example, the semantic of the relation of co-occurrence or of 
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sequential ordering. In the future, we plan to progressively add ways to let the 

analyst specify these queries from a graphical interface based on the visualization of the 

trace. 

The “Edit” tab allows the analyst to visualize the resulting trace in a similar way as 

the “View” tab, but it also allows her to reject the trace if she is not satisfied by the result. 

This feature helps her refine the query in search for the best symbols and inferences rules 

she can get to describe the activity from the actual data. Our system returns the number of 

times the pattern has matched in the trace. This number indicates the number of new 

symbols added. The system also provides an export function to a text file that can be 

imported into other tools like Microsoft Excel for further statistical computations. 

Queries are saved as independent files and the tool helps the user reference them. The 

database of queries associated to the ontology constitutes a representation of the analyst’s 

understanding about how to make sense of the activity trace. 

5. DISCUSSION AND FUTURE WORK 

Producing user models from an activity trace is a difficult challenge. This challenge 

relates to fundamental questions of how to construct knowledge from experience. We 

contribute to this challenge because the activity traces that we obtain constitute abstract 

representations of the activity. Once the activity traces are modeled in our system, the 

analyst can query them to answer questions about how the users perform their activity. 

The abstract activity trace database constitutes, therefore, itself a model of the activity.  
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We qualify such a trace-based model as a model “in extension” because it relies 

on a database of episodes, even though these episodes are abstracted. On the contrary, we 

qualify models produced from a theory of the subject’s cognition as models “in 

intention”. Based on our car driving activity analysis, we now plan to develop a system to 

simulate a driver, i.e. implement an automatic driver that behaves similarly as the drivers 

we have observed. For this purpose, we consider both the “in extension” and the “in 

intention” approaches.  

The “in extension” approach consists of using the activity trace database directly as a 

source of knowledge to produce behaviors. The system will assess a situation in the terms 

defined in the ontology and will generate user behaviors based on previous episodes of 

similar situations stored in the database. We name this approach Trace-Based-Reasoning 

by reference to Case-Based-Reasoning (Aamodt & Plaza, 1994).   

The “in intention” approach consists of constructing a model of the subject on top of 

the activity traces. In this approach, this model is constructed by the analyst from what 

she learns from the activity traces and from what she knows about the activity and about 

human cognition. We plan to provide the analyst with algorithms to help her generate 

these models under the form of a “state machine” based on Petri nets. These algorithms 

will be based on process-mining techniques (van der Aalst et al., 2003). We will have to 

adapt these algorithms to our traces. In particular, we will have to compensate the 

possible lack of information in our traces with information coming from the analyst’s 

knowledge. The algorithm will rely on a specification of the analyst’s knowledge to 
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generate the model from the trace. This higher modeling level will be again an 

analyst-driven cycle of hypothesis formulation and testing. 

We also consider exploiting our activity traces to construct “in intention” cognitive 

models within the Soar cognitive architecture (Laird & Congdon, 2009). The Soar pattern 

matching language is actually very similar to the SPARQL query language, which 

suggests potential outcome of our work for episodic memory modeling in cognitive 

architectures. On the other way, Soar could be an interesting alternative to SPARQL for 

our work.  

Finally, our modeling approach is analyst-driven and, as explained, we do not think 

that it could be fully automatized for analyzing high-level human activity. Nevertheless, 

in the case of low-level activity, we can imagine removing the human from the 

evolutionist and pragmatic loop, and imagine a self-driven mechanism, inspired by a 

constructivist epistemology (Piaget, 1937). This is the topic of a new study on modeling 

bottom-up learning in simple agents (Georgeon, Ritter, & Haynes, 2009). 

6. CONCLUSION 

We have implemented a system and defined a methodology to help an analyst model 

traces of sequential behavior. When modeled and abstracted in the system, these traces 

constitute a model of a subject performing an activity, because the analyst, or the 

community of analysts, can use the system to answer their questions. We have used this 
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system to analyze car-driving activity; it could also be used for any sequential 

behavior analysis. It is available for download on the Liris Lab server3. 

From a methodological viewpoint, this work demonstrates an analyst-driven 

procedure for user modeling. From a knowledge-representation viewpoint, this work 

proposes a way to represent sequential behavioral data under the form of a trace 

associated with an ontology. In terms of knowledge-engineering system design, this work 

proposes an architecture for an analyst-driven user modeling system. The paper also 

reports the user interface of this system. At the implementation level, this work 

demonstrates that such a system can be implemented through an assemblage of standard 

software modules for graph processing, graph visualization, and ontology editing. 

 

                                                

3 http://liris.cnrs.fr/abstract/ 
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